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1. Introduction

A tracking software for you to track over Google Earth real-time by your own PC;
no need to pay for the map or the service charges. It can also keep history
records for you to replay the route/time/speed point by point afterwards. And the
“Report” function will provide you the daily/weekly/monthly mileage report for
management purpose. Besides, it supports "Remote Data Server" function. The
data received by server can be forwarded to any PC links to the internet for data
sharing. It enables you to set up your own fleet management system.
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2. Requirements

(1) Make sure you did have installed a GSM SIM Card to AVL; and its GPRS
function had been enabled.

(2) FIXIP Address is required for GooTrac Server (the computer to receive the
GPS data sent by GPRS from the vehicle trackers); Intranet is not workable for
the operation.

(3) Your PC should be100% compatible with Windows O.S.

(4) Your PC must support 3D graphic.

(5) Google Earth Free Version (4.0 or later) should be installed in your PC in
advance.

(6) To display the route in different color/ width for different speed, please go to
Google Earth -> Tools -> Options -> 3D View -> Graphics Mode and choose
OpenGL mode. If you can not change it to OpenGL mode, please check if the
driver of your display card does support this function.

(7) Please check with your mobile operator for the latest & exact GPRS APN

settings.

3. File Explanation

(1) GooTrac.exe (main program)
(2) AVL900.dlI (library)

(3) AVLIOXXDS.dII (library)

(4) Config.ini (setting)

(5) VehicleDB.mdb (database)




4. Installation

Step1. Put the CD delivered with the tracker to the CD driver of your computer; click

on “GooTrac” to install the software into your computer.

o Tracking Software

.- it by yourself
'(}f’:S Tré%kmg \.:.1a PC PDA Phﬂne orzMaebile Phone

le GDL)SIE

Maps

i'-.% GooIrac

Select Installation Folder

The installer will install GooTrac to the following folder.

Toinstall in thiz folder, click "Mext". To install to a different folder, enter it below ar chck "Browse"".

Eolder:
i A\Program Files\GoPass\3oo Trach Browsze. ..
Digk, Cost...
Cancel <Back | |I  Nest> =




Step2. The installation of GooTrac is completed.

i'—_%! Goo Trac

Installation Complete

GooTrac haz been successfully installed.

Click "Cloze" to exit.

Fleaze uze Windows lpdate to check for any critical updates to the MET Framewark.

........................................

Step3. Click “Start” — “All Programs” —“Gopass” — “GooTrac” to run the program

you have just installed.

=4 GooTrac |Z| |E| r5__<|

Start Tool EReport View Help

: @ E? — 3

@1, b H E % m [ g Mear Far
IMEI Driver VehideID Data
IMEI Criver VehideID Cata

| VehicleCount: 010




5. Main Page

5 3oo Trac

otart Tool ¥iew Help
@ E’f%.@m@m
|
Driver YehidelID Data I!
S i 355632006785621 MewDriver 355632006755621 $GPRME;_D2=}24?:DDD,'A,E"r‘?rS.'?rEESJ_N_;lEUSB...
IMEI Drriver VehidelD Data
AddVehicle: 355632006785621 VehicleComat: 110

' Real-Time Track Open Google Earth for real-time tracking.

' History Replay Replay history position/ route point by point.

Display hist iti te (a line).
' History Display isplay history position/ route (a line)

Data Switch Link to the Remote GooTrac Server for data sharing.

i Edit & hicle data.
Vehicle Management it & manage vehicle data

Option GooTrac options setting.

Put GooTrac & Google Earth in the same screen, or
not.

View

@Bﬁﬂﬂ@ﬁ.m@

-
o
]

Operation instructions.




6. Easy Steps 123

First of all, run GooTrac software in your PC.

9=)E

Start Tool Report ¥iew Help

B G @ .

IMEL Driver

VehideID Data

IMEI Driver VehideID Data

VehicleCount: 010 |

Step1. Set GPRS APN - send SMS command 600# to the tracker.
600#Password #APN#IP#User#APN_Password
(ex. 600#8888#airtelnet.es#0.0.0.0#vodafone#vodafone)
<Please check with your mobile operator for the APN data. You can find the right

command in http://www.gopasstech.com by clicking "send my GPRS APN command".>

Step2. Set IP Address - send SMS command 999# to the tracker.
999#Password#ServerlP#Port
(ex. 999#8888#59.120.2.234#3000 - send the data to your server)

<Go to http://www.gopasstech.com; click “See my IP Address” to get the data.>

Step3. Set transmission time interval - send SMS command 115# to the tracker.
115#Password#XX
(ex. 115#8888#20 - send the GPS data once each 20 seconds)

", - " i

Tl
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#va

dafone

1. Set

GPRS APN

il

B ]

999#8888#59.120.

2. Set IP Address

3. Set transmission
time interval




The position data will be prompted in GooTrac main screen; you can start to track
over Google Earth. Double click the vehicle icon Google Earth will “Fly to” the

vehicle position.

ﬁ Foo Trac

otart Tool Eeport View Help
: = | I--J
R @ .
IMEI Driver VehideID Data [
(+) . :

390e32006785621 =T JE0E320067 55621 o ] : : ! i
Gl ewDriver $GPRMC 024247 000 4, 2445, 4863 M, 1 2055
IMEI Driver VehidelD Data
AddVehicle: 255032006785621 YehicleCount: 110

}__\Guugle Earth
File Edit Wiew Tools Add Help
|i._ g - !I. - -
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Right click the vehicle icon will enable you to configure the device by GPRS; to
edit the vehicle data; and to transmit the GPRS data to COM port for other
application.

T8 GooTac |Z| EI |z|

atat Tool View Help

R B R & .. .

IMEI Driver VehidelD Data '

% £ _____ MewDriver 35563 ;
set Device |
Edit Vehicle Data
IMET | EEpin ek Data i
set passweond for this vehdcle |
|

AddVehicle: 355632006735021 VehicleCount: 110

Real Time Track

Tl =R -1E

IMEI Crriver

Select Button

& IEE632006785621  MewDriver

Visible Box

For Live GPS Track over Google Earth, you must press down the icon for Real
Time Tracking @: ; and pick the “Select Button(®)”; + tick the “Visible Box|[v|”.
- Press down @1 icon will have the GPS position data forwarded to Google Earth.

- Pick “Select Button (®” will have the camera fly to the vehicle position automatically,

once when its GPS position data is received.

- Tick the “Visible Box[v]” will create a vehicle object in Google Earth. Un-tick it will

remove the object in Google Earth.




7. Status of GPS Tracker

%8 GooTrac 2.1.196

atart Tool Eeport Wiew Help

B HMaGio @ .

IMEI Driver Licence Data

D SSSESEDDE?EEE‘H MewDriver 355632006758314  $GPRMC,0F0545,000,4,4355,1372,M,01105,50, .,
D <'>4_ﬁ 1355632006758915  MewDriver 355632006785915  $GPRMC, 070543, 000,4,4355,1372,M,01105,50...
[] @1} JEEE320067535916  MewDriver 355632006735216  $GPRMOC,070545.000,4,4355.1372,1M,01105.50. ..

8 IQSSSESEDDE?BEQI? MewDriver 3556320067588917  $GPRMC,0F0548,000,40,4355,1372,M,01105,50,.,

Recerve Posthon: 255632006788915 YehicleCount: 4 10

@ The icon for SOS Alarm; will prompt when SOS function is
activated. (available for AVL-901(C) & GPS-911 only)
SOS Alarm
{} The icon for Geo-fence alarm; will prompt when the car moves
"-I"lr

over the present geo-fence range.
Geo-Fence Alarm

The icon for over speed alarm; will prompt when the speed is
@ faster than what you set in “Tool — Option — General — Report &

Over Speed Alarm | Alarm”

The icon for dis-connected device; will prompt when not any
new data received from the device for continuously 10 minutes.
T} Maybe the device is in an area not covered by GSM/ GPRS
Disconnect Alarm | network (for example, in the basement, or in the tunnel...), or
the transmission interval set to the device is over 10 minutes.
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8. Set Device

The below screen will prompt, when you right click the vehicle icon at the Main

Page (as detailed above); and select “Set Device”.

Ea 355632006789813( 355632006789813 )

IMEL: 355632006789813 || <<GPS>> A
— $GPRMC,033851.000,A,2459.8399,N, 121274287 E,9.44,203.09, 181207,,0C
VehiceID: 355632006789813 || o mottp: 59.125.28. 25 : 8088 [VehicleIP: 124.29,150.25 : 3000]
Driver: MNewDriver [RemoteTime: 2007/12/18 AM 11:32:24]  [LocalMime: 2007/12/18 AM 11:32:09]
GPRS IP: 124.29.150.25
. <GPS
Port: 3000 $GPRMC,033851.000,A,2459.8399,N, 12127.4287,E,9.44,203.09, 181207, *0C
On-line builds up time: [RemotiP; 59.120.2.234 : 8088] [VehideIP: 124.29.150.25 : 3000]
2007/12/18 AM 11:32:07 [RemoteTime: 20071218 AM 11:39:24]  [LocalTime: 2007/12/15 AM 11:39:09]
[ ] birect Send Clear | 2

.....................................

=] (| T — —
% | | Confirm New | | Set F‘asswn:urd|

’Q} Power Save Send

2007/12/18 |+ % Wake UP Send
— [ SetTme || | ¥

11:39:31 | 2 =

Lot Reboot device Send
| | Get Time a«;

Reset to default setling | Send

Clear all data in 5IM Send

APN internet | IP [0.0.0.0 |
IDI:I Password :I IF |gis.g|:npass.| Part |21

D |g|:||:|ass | PW |“"“*

et =
ABN | | File |fusrf9xw3-ﬂ-ﬁm | [ FirmwareUpdate l

The messages received from the GPS Tracker will be displayed in the top

column.

NB : "Set Device” works over IP. FIX IP is required for the operation.

11




(1) General ﬁ

dari | Getmver |

ci%:r.h] | Get Version |

%ﬂ VONY 7 1 | Set Time |
15:39:00 =

% | et Time |

APN [internet 1P [0.0.0.0 Set APN
ID Password
ars | Getan |
o’
Old New
Confirm Mew Set Password
!Ef} Power Save Send
.‘.ﬁ'ﬁ Wake UP Send
' =3
Lo Reboot device Send
g Reset to default setting | Send
%'é Clear all data in SIM Send

12

Get IMEI:
Get IMEI of the device.

Get version:
Get Firmware version

Set Time:
Set the time of the device.

Get Time:
Get the present time of the device.

Set APN:

To set APN for the SIM card installed
in the device, so that the device can
send back data via GPRS.

Get APN:
Get APN setting of the device.

Set Password:

To set the password for the device.
The default value is “8888”.

- Power Save Mode

- Wake up from Power Save
- Reboot the device

- Reset to default settings

- Clear all the data in SIM card




(2) Track @

&=

2

[
] H
: H
: {T* :
a MY
!-- - --‘

Get Position (GPRKMC)
Get GPS data once

Get position (x,v)

Send

Send

et
-

-

Set GIS Server parameters
IP |59.125.28.2 | Port [3000

Get GIS Server parameters

Send

Get GPS Data once:
Get GPS data in GPRMC format.

Get position(X,Y):
Get GPS data in various formats.
<GPS>, <Google>, <Standard>, <Deg>

Set GIS Server parameters:
Change the IP/ Domain Name &
Listen Port of Call Center Server

Get GIS Server parameters:

e

I | Send |
_ Set GPS delivery time interval:

e R .

tfl’?j [ ] Disable delivery

= Time: [50 (s)
@{;3 Get Interval Setting
t"} - Send

Get IP/ Domain Name & Listen Port
of the Call Center Server.

Set delivery time interval:
Set the time interval in seconds for
the device to send back data.

Get delivery time interval:
Get the preset time interval for GPS
Tracker to send back data.

The below table allows you to add/ delete the phone numbers, which can get the position data

from the device, after it rings twice, and is not answered.

[

Set Phone Track List
[ |Enable
Add
| Send |
et Phone Track List
| Send |
Phone Track

w | Send
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Set Phone-Track list:
Set up the phone numbers list for
phone-track function.

Enable: activate the phone#.
Add: Add new phone# to the list
Del: Remove from the list

Get Phone-Track list:
Get the phone numbers list for
phone-track.

Phone Track:
Activate or disable Phone Track
function.




Universal Command (CMD,Data)

M2

a

| Send |

Universal Command:

(3) Phone Eﬁ

|

== |  Phone

MName

Set the first set phone number

Get the first set phone number

2N}

| Send |

MName

E Set the second set phone number
T2 Phone

Fﬂ-'h Get the second set phone number

Reserved for factory use only.

Set the first set phone
number:

Set the first set dial-out phone#
(can be with or without the Name)

Get the first set phone
number:

Get the phone number of the first
set

dial-out phone number.

Set the 2nd set phone
number:

Set the second set dial-out
phone#

(can be with or without the Name)

Get the 2nd set phone
number:

Get the phone number of the
second set dial-out phone
number.

T?’) Auto phone answering

Auto answer after

3

rings

% =]

Auto phone answering:
Set for Auto Answering mode.

({1l

n” - into Auto Answering

mode, after rings “n” times.
Switch: On or Off

14




(4) Park ae

Set Geo-Fence Phones

Get Geo-Fence Phones

Send

Set Geo-Fence alarm interval

Time: &0 (=)

Set Geo-Fence alarm distance

Fhrmy

Get Geo-Fence settings

@0
P

By

8

Geo-Fence alarm switch

Switch W

Set Geo-Fence notification mode

Mode w

15

Set Geo-Fence Phones:

Set the phone# for device to call back,
when the vehicle is moved over the
geo-fence range.

Get Geo-Fence Phones:
Get the phone# for Geo-fence.

Set Geo-Fence alarm interval:

Set the time interval for the device to
send back the SMS alarming message,
when the vehicle is moved over the
preset range.

Time: interval in seconds to send.

Set Geo-Fence alarm distance:

Set geo-fence range in meters. Device
will send back alarming message to the
preset phone number, if the car is
moved over the preset distance range.

Get Geo-Fence settings:

Get the setting details of Geo-fence
function.

Geo-Fence alarm switch:
Switch: Off / On

Set notification mode:
Set the advising mode for geo-fence
function.

Mode: SMS / TEL




(5) SOS A\

Eﬁg Set 505 notification phone

Del

Send

i

@sg§ Get 505 notification phone

=5

Send

i

f. ResetSOS status

16

Set SOS notification phone:

Set the phone numbers for device
to send back the SMS alarming
message, when SOS button is
pressed down.

Get SOS notification phone:

Get the phone number list of the
phone numbers can receive the
SOS emergency message.

Reset SOS status:

Cancel SOS status and return to
normal condition.




(6) Daily Call Back %"

?:e;, Set Time Table b

H i

et w| (17:08 % | | Send
i, Get Time Table Send
AN

@ Set daily call back redpient {(phone)

Add

aig

Send

]

(E'_ﬁ _i’ et daily call back recipient {phone)

Send

i

WES 1 OnfOff Daily Call Back

&
a9 ¥ =)

i o
N (T
e

Set Time Table:

Set the time table for device to send

back data automatically every day.
Sets: 5 sets in total can be used.
Set1 ~ Setb5
Switch: On / Off

Get Time Table:
Get the time table for device to send
back data automatically every day.

Set daily call back recipient (phone):
Set the phone number(s) to receive the
data of daily call back.

Get daily call back recipient (phone):
Get the phone number list of the ones
who can receive the data of daily call
back.

Turn On/Off Daily Call Back:
Activate or shut off the function of daily
call back at the preset time(s).




9. Default Password

(1) Tool— Default Password

ﬁ GooTrac

otart MG View Help

: Dptinn Cal0 —
? @ Pipe Oiption cewp |3
——  (3-Mouss Ophion Cal+

- BIX

Fo &%

IME  Vehicle Management Chl+d
[ Diefanlt Pagswond
0"  Data3witch

IMEI

Tn Default Password

YehideID Data

AE-1234 $EPRMC ,040132.000 4 ,2500,3998 M,12129,

Con

Use Default Passward

firm Passwaord IEI

K | | Close |

Tick “Use Default Password’, if you want to use the default password “8888” to

send commands to the device.

If “Use Default Password” is un-ticked, the following screen will prompt for you to
set up the password, when you send a command to the device.

5 ¥ehicle Fassword

|:| Remem

ber this password”

Password | |

Ik, | | Cancel |

18




(2) Set password for this vehicle

~a GooTrac IZ‘ @ig'

Start Tool View Help

El- L CEEN

| IMEI Driver VehidelD Da

$GPRMC,073832.000,A,2233.6511,N,113....

Es;t Deevice
Edit Yehacle Data
Fipe to COM

IMEI

-j Set pazssword for thiz vehicle @

Confirm Password E

Key-in the password twice; and click “OK” to save the password. If you want to
remove the saved password, clear all the data in the columns (keep them blank),
and click OK.

If "Use Default Password” is not ticked, and the password has not yet been set,
the following screen will prompt for you to key-in the password every time when
you send a command to the device.

seneral @' Track ﬁ Phone .ﬁ, Park & 505 ;F Daily Call Back

8 Yehicle Password

[]remember this password”

I Save
’ QK l ’ Cancel l
a 2007/11/ up
15: 3900
bt device
B T GetTme 11 1~

19




10. Vehicle Data Edit

T8 Vehicle Data EditBox

IMEI: 355632003721371 \ &

Criver |Demo
Description

VehicleID |Demo-1234

Tel

Addr

Save | | Cancel

Click the red car on the top right to open “Icon List” screen; select the required icon;
click “OK”, and then “Save”. After then, the selected icon will be displayed on Google
Earth, when you are in Real-time Track, History Replay, and History Display modes.

E Icon List

o ST} I o

ambulance_01...  bike_071.gif bike_02.aif bus_07.aif bus_ 02 aif

R e = gms

bus_ 03 aif bus_ 04 agif car_01.gif car_02. gif car_03. gif

e = = o L

Ham By -iF s

20




11. History Replay
(1) Easy Replay

Select the vehicle (system will

. display all the vehicle with
E History Replay Pay

record in this month)
Eazy Replay l Universal Beplay

Select the month

Year Maontk  Vehicle
2007} [o3 +| [E1234 v

20073729 AM 11:53:17~2007/3/29 PM 12:04:55
200773525 PM 01:47:34~2007/3/29 PM 02:00:58

Display all the tracks in the

selected month (Tracks will

break up as per the settings

in the Option. “Add a new

track when the vehicle was

disconnected over 30

minutes”)

21




(2) Universal Replay

E History Replay

To have the route looked
neat on the Google Earth,
the interval of route dots
should be set to over 3
seconds.

22

1

|

To replay the route point ¥ FERlay Universal Replay
by point of the selected Set the starting ]
car during the selected |Fiom [2007/ 6/30  »| 094003 = | Jatestime
period. - | r
To (20074 743 = 09:40:13 = Sefitielendiis
Vehicle (S gz - o dd date & time
s Del r
Get a position data every
1000ms (min. 100ms). It Add a new Vehicle to the
will affect the reply speed. list for history replay.
. N
Check Position Interval |-I aoo [mz]
Sampling frequency E [=]
I ‘ | Fepeat Replay Cloze




12. History Display

(1) Easy Display

5 Hiztory Dizplay

Eazy Dizplay l Urniversal Display

1

Select the vehicle (system will
display all the vehicle with
record in this month)

Select the month ]

T'ear

k arth

Wehicle

2007

-1 04+

Derno-1234

200774720 AM 09:55:56~2007/4/20 AM 11:45:13

Dizplay

Cloze

23




(2) Universal Display

©a History Display

Easy Digplay  Universal Display

Set the starting ]

Ef 5/30 - 034013 date & time
) EEICE i — Set the ending
date & time i
Vehicle  [Demo-1234 <[ add !
Del

Add a new Vehicle to the
list for history replay.

24




(3) Color of various speed

i

Fiela | Fodd Pusegposs | Dereciors

-2
LM EE
. P
o —
= =] R Py e Pl e
- I

= A ks B O LT
=TT o

1) B
L, . S— E

(4) Mono color

b e gl Bl
bt —

= Swaiih

Fiela | Fodd Pusegposs | Dereciors

-2
el B B
 Phisei
T
= o R Py e Pl e
- I

= A ks B O LT
=TT o

1) oW
L, . S—




13. Pipe to COM

To transfer the position data to a COM port for real-time track over the
navigation map installed in your PC. Please click here for the full details about

how to track with the navigation map.

Btat Tool Wiew Help

e

R o @ .

IMEI Driver YehideID Data
% 355e32006755621 MNewDriver
set Device
Edit Vehicle Data
IMEI JEE ecliolSE Data
set pazzwornd for thiz vehicle
Iﬂdd?ehicle: 355632006735621 VehicleCount: 110

26




14. GPRS Receiver

To activate GooTrac's GPRS Receiver function to receive position data from

the GPS Tracker for real-time track over Google Earth and/or over navigation

map. The default of GPRS Receiver function is enabled.

ﬁ Goo Trac

e Tool Eeport Wiew Help

Bealtime Track Ctl+T
History Dizplay Ctl+R
History Display  CtltD

@ @ &

. T J : -
0 Q Mear Far

Driver VehiceID Data
v GPRE Recetver ChltAlt+E
F-Movm Mode ChltAlt+G MNewDriver J9563Z006735621 $GPRMC 024247.000 4 2445, 4563 M,12055. .,
Demo Cirl+ A1+ D
Bt Cirl+E
= river YehiceID Data

AddVehicle: 355632006735621

YehicleCount; 110

27




15. G-Mouse Mode

To activate GooTrac's Serial Port function to receive GPS position data from
our trackers or other GPS devices for navigation or for history replay. When you

use it for the first time, please set “Tool -> G-Mouse Option” in advance.

E (3-Monse Ophon

Data Port COM

BaudRate 115200 -
Farity Mane ]
Data Size E ~]
Stop Bit 1 | P Tool Tiew Help

Eealttime Track Ctl+T C
Hiztorr Beplay Chl+RE ) ﬁ

History Display  Cti4D

Lriver

(1PRS Receiver Ctl+Al4R 2
v O-Mouse Mode Chl+AIMG

CHl+A4+D

Exit ClE

ﬁ Goo Trac

S[=1/E3

gttt Tool Wiew Help
Yol s i
@1 '3 B =1 Mear Far
IMEL Driver VehicleID Data 3
@\ A55632006785621 MNewDriver JS5632006785621  $EPRMC 024247000 4 2445, 4563 M,12058. .,
IMEI Drriver VehideID Data
AddVehicle: 255032000°735621 YWehicleCount; 110

28




16. Data Switch

GooTrac can link to the Remote GooTrac Server for data sharing. The below
is the main screen of GooTrac program. The top column displays the GPS data
received directly from GPS Trackers via GPRS; while the bottom column displays

the GPS data received by the Local GooTrac from Remote GooTrac via internet.

- B

FREYaG @ .

IMEI Diriver VehideID Data

& I55632006785621  Driverd AB-1234 $GEPRMC 0401 32,000 4 ,2500,3995 121,

GPS Data received from GPS Trackers via GPRS

IMEI Diriver VehideID Data
Qﬁ F355632004 240907 Zarl DF-5675 Skark up: 355632004246907
2 ﬂ F55632004 235660 Person QL-9945 Skart up: 3556320042 35660

GPS Data received from Remote GooTrac Server via internet

AddVehicle: 355632006785621 WehicleCount: 1 12

Please select “Tool” — “Data Switch” from the function menu, and set it up as

detailed below.

29




(1) Data Server

Function: To forward the GPS Data received via GPRS from the GPS Trackers

to all the logged in computers (Clients) thru internet. The below image

illustrates how to set up the accounts in Data Server.

:E Data Switch

Data Server | Client | Active Client |

ﬁ] Status: ONg=—— Server Activate

N
Data Relay
Active Username Password Count State

218.167.68,31 Connected

Activate or disable this account

How many users use this account to log-in

% add FBX

Edit

Active

Username

liptest |

Password

Confirm Password

@Server Activate

Users can log in this computer

l:‘,ﬁServer Disable

Users can not log in this computer

Data Relay

Tick to activate the function for forwarding the data

received from other Server to the Clients.
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(2) Client

Function: Link to Remote GooTrac Server to get the GPS Data received by the
Remote GooTrac Server. The below image explains how to link to the
server.

Please key-in the IP Address of Remote GooTrac Server; “8088” as the Delivery

Listen Port; and Username/ Password as set up in Data Server.

5 Data Switch

Data Server | Client |Acﬁve Client

Client Activate

(@) s
ﬂ.« StatussON - The delivery listen port of the server (8088 is default value) Del

Active Target IP Target Port Llsername Password State
59.120,2.234 3033 iptest — Connected
The IP Address of the Data Server Connection status

FEX

Active
I Target IP IUzemarne
[59.120.2.234 | [intest |
T arget Port Pagzsword
|BDBB | [E— |

Confirm Paszsward

HEEEEN |

Save | | Cloze |

Log in the remote server to get the GPS data

Stop the connection;

P
EB;CIient Activate
f]

Client Disable stop receiving GPS data from the server.
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(3) Active Client

Function: Link to the remote server, and forward the GPS data to the server
actively.

Application: For the data server with firewall. It avoids Clients unable to log-in
the data server protected by firewall.

The below image explains how to set up Activate Client. Please key- in the IP
Address of the remote server; “8088” as the Port; and Username/ Password as
set up in the remote server.

5 Data Switch

Data Server | Client | Active Client |

| Status: oN €= Client Activate Add ] [ it l ’ - ]
"

Active Target IP Target Port Username Password State

192.168.1.55 30883 test rree

Active

Target P [Jzemame

[192.168.1.55 [test

Target Port Paszzwiord
I |BDBE |xxxx

Confirm Pagsword

[:% Log in the remote server for forwarding the
—=¥Client Active GPS data actively.

ot
. ] Dis-connect to the remote server.
mChent Disable
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(4) Allow List (Data Server)

Function: To select the vehicle to be monitored by each account. Double click
the Username; the “Allow List” window will prompt. Select the vehicle
to be monitored by this Client; and move the data from the right
column to the left column. The below image illustrates the set up of
the allow list for user “gopass”.

:-'i Data Switch

Data Server | Client || Active Client |

@‘! Status: ON

Data Relay

Active Username Password

Edit

Double click to open the “Allow List” windowv.

Ta Allow List

Allow

Mot Allow

IMEI VehideID

355632001914127 AB-1234
355632002555754 DE-9978

IMEI VehideID

355632003721371 Demo-1234
353632002549625 DD-0123

-

Add All

Clear

35563200

Use Allow List

Tick “Use Allow List”

Only the vehicle data in the left column (Allow List)
will be forwarded to this account.

Un-tick “User Allow List”

All the vehicle data will be forwarded to this account.
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17. Options

Visual |Genera| Report & Alarm | Language

Color/Speed| [“]Kilometer/hr [ IMile/hr )

] Mnnnchrnme- - - - - - -
0¢= -{—-{ <=[20 = [40 <=[60 |<|  <=[s0

<=[g0 |< | <=[100]< -{— 110| <= -<— 120/< |

A3| Width|6 |  Opacity[50 % |A4
[

[ _

B1|[CIFreeCamera Range B4 Tit—{BS

1T Near Far 0° B0°

B2 | [¥IFix Azimuth [Morth  w 3 J

] Circumrotation Camera Speed ||36 Time Stamps|B7

B3 Slow Fast More Less
| — | J— '_J—

Monochrome. One color for all the different speeds. For multiple vehicles tracking,

Al|l | each vehicle with its unique route line color for easier recognition. Ex. Yellow route
color for the first vehicle; and blue route color for the 2nd vehicle; ...

A2| | Change the route line color when speed changes.

A3| | Set the width of the route line

A4 | Set the transparency of the route line

B1| | Tick for free camera.

B2| | Fixed camera angle — the camera viewing angle will be fixed to one certain direction.

B3|  Rotate camera viewing angle (B2: Fix Azimuth can not be ticked).

B4| | The range of Google Earth camera and the target position.

B5| | Tilt angle between Google Earth camera and the ground.

B6| @ The speed of Google Earth camera flies to the target position.

B7| @ Set the extent of time stamps
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5 OpHons

Vi

sual | General | Report & Alarm | Language

[“]Fly to the new device when it's connceted.

[¥]Dan't fly to the position when the speed is less then |5 | km/hr

Add a new track when the vehicle was disconnected over |30 | minutes.

[v]Clear vehicle track that was disconnected over 30 minutes.

[“]\When the speed is slower than|2 |km/hr, take it as GP'S stationary drift.

[v] Show GoogleEarth description balloon on click.

[“|Highlight the vehicle & position data in the main screen when vehicle is maving.

Server Listen Port{3000

F.S

SwitchServer Listen Port Connection Retry ~ Retry Interval
D3 D4

C1l

C2

C3

C4

C5

C6

OK

Fly to the new device when it is connected

Do not fly to the position whe the speed is less than ? km/ hour.

Add a new track when the vehicle was disconnected over ? minutes.
Clear vehicle track that was disconnected over 30 minutes.

When the vehicle is stationary (parks/ does not move), then there will be a GPS
position drift. This kind of position drift is the nature for GPS application. It can not
be eliminated. The distance of drift varies to GPS signal strength, which relays to
the environment/ parking place... (ex. if the GPS accuracy is 2 meters, then the
speed/ hour will be 2 meters * 60 seconds * 60 minutes = 7.2km/ hour. To remove
such data from the system, please tick this option, and set the speed to 7.2km/hour
to clear those in-valid position data.)

Tiick this option to prompt a description window, showing driver, license#, speed,
lattitude, longitude, and the time..., on top of Google Earth window when double
click the vehicle icon in the main screen for real-time tracking
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C7

D1

D2

D3

D4

It enables you to distinguish if the vehicle is moving or stationary. For the vehicles
which are moving, the data displayed in the main screen will be in "black™ color; for
the stationary vehicles, the data will be in "gray" color.

Server Listen Port. The port to receive the GPS position data sent from the GPS
Trackers. (The default is “3000”).
Data Switch Delivery Listen Port of Remote GooTrac Server. (The default is “8088”)

How many times the Client PC to retry the connection to Data Server after
dis-connect. (The default is 60 times)

The time interval for the Client PC to try to re-connect to the Data Server in Data
Switch. (The default is 60 seconds)
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r

]_ Over Speed! Alarm! Switch (OFF w

ﬁ Ophons

Visual | General | Report & Alarm | Language

Report settings (GP 5 Stationary Drift Settings)
E1 |[¥lignore the data if the speed is slower than [5 | km/hr

[+]Ignore the data if the distance of two positions is less than |10 [ meters

[«]lgnore the report if the total mileage is less than (1.0 km

Alarm settings

Fl:l SOS! Alarm! Switch [OFF  » | | \001.WAV

F3 3'_-?.,.;‘ Geol Alarm! Switch |OFF v | [AD02. WAV =) [

H %)

Speed imit[110  [km/hr | \003. WAV = F7

E1l

If the speed is slower than the setting value, take it as GPS stationary drift data. Click

this option to remove such data from the report calculation to minimize the deviation.

E2

If the distance of 2 points is less than 10 meters, take it as in-valid GPS stationary

drift data. Click this option to remove such data from the report calculation.

E3

If the total distance of a drving route is less than 1.0KM, take it as in-valid GPS

stationary drift data. Click this option to remove such data from the report calculation.

F1

SOS Alarm switch on/ off button

F2

To select the path and file name for SOS alarm sound

F3

Geo-fence Alarm switch on/ off button

F4

FS

F6

To select the path and file name for Geo-fence alarm sound
Over Speed Alarm switch on/ off button

The speed limit set for Over Speed Alarm

F7

To select the path and file name for Over Speed alarm sound
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Visual | General | Report & Alarm | Language

Select Language |23 l::%:ﬂ

Default | |

DK

| | Cancel

G1

Chinese Traditional, and Chinese Simplified.
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18. Export Log to Excel format

Step1. Open file VehicleDB.mdb

Win XP -> C:\Documents and Settings\All Users\Application Data\Gopass\GooTrac

Win Vista -> C:\ProgramData\Gopass\GooTrac

Step2. Choose “Log” in the Data Sheet.

Microsoft Access

BRE #BE HRO A0 IBEO #Ewm HEo FEERTHAE
NDEHR AV YRR 95 A- e |F=54-@

fE vehicleDB : B (Access 2000 3R
LOEEE BEEED) R | X | 2o e || EE
Ot {EAREHRRET T E
= {E AR
- FEmEA TR R
B CMDLog
3 =B

Diriver
LaztLog

B oo
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Step3. Open Log in the Data Sheet.
ELog: HHE

[t Pl i} Pt nlnla NI T e T el ol n B T W L |

e LR || 1 v | wi e = 2042

AFESAnEEATIe A

1

=10l =]
LogDate Time Valid DevicelD | GFEC &
20074420 F4F 02:41:10 355632003721371 BGPRMC,074026.000,4,2410 961 3,0,120—
2007/4/20 F4F 034103 355632003721371 BGPRMC,074021 .000,4,2410.9511,1,120
2007/4/20 7F4F 02:40:58 355633003731371 BGPRMC,074016.000,4,2410.9609,H,120
2007/4/20 7F4F 02:40:53 355622003731271 $GPRMC,074011.000,4,2410.9507,H,120
2007/4/20 F4F 034048 355632003721371 $GPEMC,074006.000,4,2410 9606,M,120
20074420 F4F 03:.40:42 355632003721371 $GPENMC,074001.000,4,2410 9605,M,120
20074420 TF4F 034037 355632003721371 $GPENMC,073056.000,4,2410 9607,M,120
20074420 F4F 034032 355632003721371 $GPENMC,073051 .000,4,2410 9609,1,120
20074420 F4F 034027 355632003721371 $GPENMC,073046.000,4,2410 961 1,N,120
20074420 F4F 034022 355632003721371 $GPENMC,073040.000,4,2410 961 2,N,120
20074420 F4F 03:40:17 355632003721371 $GPENMC,073035.000,4,24109614,N,120
2007/4/20 F4F 02:40:12 355632003721371 $OPRMC,073930.000,4,2410.951 5,1,120
2007/4/20 F4F 02:40.07 355632003721371 SOPRMC,073025 000,4,2410.9515,1,120
20074/20 F4F 02:40:02 3556320037213 SOPRMC,073020.000,4,2410.9516,1,120
20074020 7F4F 02:39:57 355632003721371 SGPRMC,073015.000,4,2410.9517,1,120
20074420 7F4F 02:39:52 355632003721371 SGPRMC,073010.000,4,2410.9617,1,120
20074020 F 4 02:30:47 355632003731371 SGPREMC,073005.000,4,2410.9518,1,120
20074020 F4F 03:30:41 355632003721371 SGPREMC,073000.000,4,2410.9516,1,120
20074420 7F4F 03:39:36 355632003721371 BGPRMC,073855.000,4,2410.9516,H,120
200724420 F4F 03:32:31 355633003731371 BGPRMC,073850.000,4,2410.951 5,H,120
20074420 7F4F 02:39:26 355622003731271 $GPRMC,073844.000,4,2410.9515,H,120
20074420 F4F 03:30:21 355632003721371 $GPENMC,073830.000,4,2410 9616,M,120
20074420 F4F 03:39:16 355632003721371 $GPENMC,073834.000,4,2410 9616,M,120
57052 2007M420 T 03:39:11 355632003721371
]

AL APAnO . Onm L

$GPEMC,073520 .DDD,A,E#ID.QEIE,H,li]ILI
4

Step4. File > Export
Microsoft Access

BED | BEE WEI BAD 8D

] ESEEERQD.. Clll

L REEEEO. Cte+0
Brig s aR @) 3
BAESEEC)

= EETRED Chl4d

miRE) THROD REin SN %

2d &G T[4

pﬂ jj.-::'fgv |

S

[ EEE. ) ;

- IEE

=4 FUELE... Ctrl+P
{EEED »
EEEREERD
1 '"Program Files\Gopassh..\WehicleDB mdb
24 \WehicleDBZ mdb
2% \WehicleDE mdb
4 e IME\WebsitehVehicle DB md b

B i

=3
HHHHHHHHHHHHHHHH%
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355022003721371 BGPEMC,0740%
355632003721371 BGPRMC,07400
355632003721371 SGPRMC,07401
355632003721371 SGPRMC,07401
355632003721371 SGPRMC,0740C
355632003721371 SGPRMC,0740C
355632003721371 BGPRMC,0730"
355632003721371 BGPRMC,0730"
355632003721371 BGPRMC,0730:
355632003721371 BGPRMC,0730:
355632003721371 BGPRMC,0730]
355632003721371 BGPRMC,0730]
355632003721371 BGPRMC,07307
355632003721371 BGPRMC,07307
355632003721371 FGPREMC,0730]
355632003721371 EGPRMC.0730]




Step5. Choose the format of export, ex. Microsoft Excel 97-2003(*.xls).

R L e S
i )My Mirkual Machines
P [_Jonion_cuskam_emakicons_01
(] Source Insight
I [ visual Skudio 2005
S I SE: =T o
= . I
¢ | EEEED | o I = i o] ]
- BIAEENT):  [Microsoft Office Access (*mdb| - I E@EEr | Hw |
g F
" = ﬂmrﬂmg‘t E}:‘:E%i {:ﬁ} Ll ry=ams LR A AR e g e e " :
wrosntt Bxce .
57045 20074420 T 0339000 = _': 131 POPRMC,073544 000,4,2410 961,
ST050 20074420 T 03:39 [ i M $GPRMC,073339 000,4,2410 9611
5051 20074420 T 03:39: Tt T WTIE L '”fg = 1271 $OPREMC,073534 000,4,2410 9410
a -2 e
57052 20074420 T 03301 = (Xwid) o 1371 $OPRMIC,073529.000,4,2410 961
Step6. Name of export file, ex. Log.
E Microsoft Excel - Log.xls = =]
H) #RE SO SE0 BA0 #3200 IAD BTHD #Ew HEO BRSNS -
DEHRS S IE LR 98 = 2] @ Hnne -0 - B I U
4l - £ 'ID
A B | C | D | E [F] & H L= =
1 [0 losDawTic valid  DevieeD GPSData CMD Lat Sizn Latitde Lo Sien Longitde Alftde Geoid  Spesd =
| 2 | 57mo 2007H40 TRUE 355632005721371  SGPRMCOMMIEN00A 24109613 M 120363858 007, 200N .18269 E 1206143 0 0o oof
| 3 | 57030 200700 TRUE 355632003721371  $GPRMCOMOIL000,4 24109611 N 1203638625010, 200N 2413269 E 1206143 0 0 ol
| 4 | smsl 200700 TRUE 7385632003721371  $GPRMCOMOIE000,A M 109600 120368966005, 200N .19268 B 1206143 0 0 00
| 5 | 503 200700 TRUE 355632003721371  SGPRMCOMON1000,4 24109607 M 120363868 E012, 200 N 2418268 E 1206143 0 0 ol
| 6 | 57033 2007H40 TRUE 355632003721371  $GPRMCOMO06.000,4 241090606 12036387, E012, 200N 2.13268 E 1206143 0 0o ol
| 7 | 5703 2007400 TRUE 355632003721371  $GPRMCO7001.000,4 24109605 N 120363872 E008, 200N 2.13268 E 1206143 0 0o o
| 5 | smos 2007n0 TRUE 7355630003721371  SCPRMCOTION000.A M109607M 12038961017, 20N 24,1268 E 1206143 0 0 o7
| o | 57036 200740 TRUE '355632003721371  SCGPRMCO73951.000,4 24109609 120368857 E008, 200 N 2.18268 E 1206143 0 0 008
10 | 57037 200740 TRUE 355632003721371  $GPRMCO73M6.000,4 24109611 N 12036385, 5010, 200N 2413269 E 1206143 0 0 ol
11| 5788 200700 TRUE 7385632003721371  $GPRMCOTIMO0000A M109612M 120368845 E010, 200N M.19269 B 1206147 0 0 0l
12| 57039 2007420 TRUE '355632003721371  SGPRMC073935.000,4 24109614 M 120363M40E 016, 200N 24.18269 E 1206147 0 0 ols
13| 57040 2007820 TRUE 355632003721371  SGPRMCO73930.000,4 24109615 M 120363836 E011, 200N 2.18269 E 1206147 0 0 oll
14| 51 2007400 TRUE 355632003721371  $GPRMCO73005.000,4 24109615 N 120363834 B0, 200N 2.13269 E 1206147 0 0o ol
| 15| 5742 200700 TRUE '355630003721371  $OPRMCOTION0000.AM109616M 12036883, E015, 20N 2413269 E 1206147 0 0 ol
16| 5743 2007420 TRUE 355632003721371  SGPRMCO73915.000,4 2410961 7N 120363830E008, 200 N 1827 E 1206147 0 0 008
17 | 5704 2007400 TRUE 355632003721371  SGPRMCO73010.000,4 2410961 7N 120363829 E016, 200N .1327 E 1206147 0 0 ols
| 18 | 5745 200700 TRUE 355632003721371  $GPRMCOTI005.000,4 2109618 M 120%6.8928 009, 200N U.1927 B 1206147 0 0 0w
19| 576 2007420 TRUE 355632003721371  SGPRMCO73900.000,4 2410961 6N 120363829 E009, 200N 24.18269 E 1206147 0 0 00
| 20 | 5747 2007H20 TRUE 355632005721371  SGPRMCO73855.000,4 241096161 12036383, E013, 200N 2.18269 E 1206147 0 0 o3
21 | 578 2007400 TRUE 355632003721371  $GPRMCO73850.000,4 24109615 N 12036 3830E010, 200N 2.13269 E 1206147 0 0 ol
| 22 | 5749 200700 TRUE 7355630003721371  $OPRMCOTIS4.000.4 2109615 M 1203688205012, 20N 2413269 E 1206147 0 0 ol
| 23 | 57050 2007420 TRUE 355632003721371  SCPRMCO73839.000,4 24109616 120363829 E013, 200N 2.18269 E 1206147 0 0 03
| 24 | 57051 2007400 TRUE 355632003721371  SGPRMCO73834.000,4 24109616 120363828 008, 200N 2413269 E 1206147 0 0o o
| 25 | 5752 200700 TRUE 355630003721371  $GPRMCO7TI820.000,4 M 1096160 120%6.8925 014, 200N M.19269 B 1206147 0 0 o
| 26 | 57053 2007400 TRUE 355632003721371  SCPRMCO73824.000,4 2410961 7N 1203638226017, 200N 24,1827 E 1206147 0 0 o7
| 27 | 57054 2007H40 TRUE 355632003721371  SGPRMCO73819.000,4 2410961 TN 120363816 E011, 200N U.1827 E 1206147 0 0 oll
| 28 | 57055 2007400 TRUE 355632003721371  $GPRMCO73814.000,4 24109618 N 12036 3810E008, 200N M.1827 E 1206147 0 0o o
| 29 | 5756 200700 TRUE '355630003721371  $CPRMCOTIS00.000.4 M 109620 12038805 015, 20N 24,1827 E 1206147 0 0 ol
WL AIET TR0 TRITR '%%m?mqmm’ﬂ FOPRERCTTIA0 (LA M MSA? D 103 BRI BN ’}I"l?hi MR 1" A1d7? ﬁl il I’W_I"IIQJLI
M 4 ¢ H 4 »
BER- Lk [PEERO- N NDOOH W42 @lE S-Z-A-S=g@dy
B NUM
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19. FAQs

Q1. Why | can’t find the IMEI# of my device in GooTrac main screen?

It is because the position data of your device still can not be sent back to GooTrac server by
GPRS. There must be some problem with the SIM card, or the GPRS APN settings, or some
other telecom problem. Following are some of the possible factors which may cause the
data can not be sent back to GooTrac server by GPRS.

1. The APN setting is not correct
Please check with your mobile operator for the latest & exact GPRS APN settings; if
User_Name & APN_Password required for the APN settings. Please note that the data
provided by us were what found in the internet, which maybe out of date. You must check
with your local telecom company for the correct APN data.

2. The SIM card does not support GPRS communication
Please check with the telecom company if the GPRS function of the SIM card has been
activated. Maybe the SIM card does support GPRS; but not yet been activated. You must

call & ask the telecom company to have the GPRS function opened.

(*Please note that one can link to internet by WAP, or MMS, or GPRS; but only GPRS is good for
real-time tracking; WAP & MMS are not workable - i.e. it is not for sure that the SIM Card does work on
GPRS, even though you can link to internet with the SIM Card.)

3. The GPRS communication is simplex, not duplex

Please check with your telecom company if the GPRS communication is duplex not simplex
- i.e. the device can both receive & send out GPRS data.

4. The 3 SMS commands to set up the GPS tracker were not sent correctly

Please double check the 3 SMS commands sent to the device, and make sure the

commands were sent correctly.

5. Firewall or Anti-virus Software
The operation of GooTrac is blocked by firewall or anti-virus software. We suggest you to
disable all the firewall/protection for the PC used for testing; and have this PC linked to
internet directly, not thru router/intranet... After the communication problem solved, then you
add on the required protection one by one, so that you can find out where the problem
resulted from.
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Q2. How to set GPRS APN?

Please check with your telecom company for the following data beforehand.

The Access Point Name (APN) of the telecom company.

Is the User_Name and APN_Password required for the APN setting?

You can refer to http://www.gopass.com.tw/other/APN Table.pdf for the examples of the
GPRS APN set-up.

Please make sure the SIM card does support GPRS communication; and the GPRS

function has been activated.
Please note that WAP and MMS are not workable for real-time tracking; GPRS is a must
for the operation.

Please send the SMS command "600#Password#APN#IP#User#APN_ Password"
referring to following examples.

Example 1: Vodafone (Airtel) - from Spain

APN: airtelnet.es | Username: vodafone| Password: vodafone
600#8888#airtelnet.es#0.0.0.0#vodafone#vodafone
(*must key in "0.0.0.0" as the IP, when "User" & "APN_Password" is required)

Example 2: Telefonica (Movistar) -from Spain

APN: movistar.es | Username: movistar | Password: movistar
600#8888#movistar.es#0.0.0.0#movistar#movistar

Example 3: Telmore (TDC) - from Denmark

APN: internet | Username: tdc
600#8888#internet#0.0.0.0#tdc

(*must key in "0.0.0.0" as the "IP", when "User" is required)

Example 4: Telia - from Denmark
APN: www.internet.mtelia.dk | Username: telia
600#8888#www.internet.mtelia.dk#0.0.0.0#telia

Example 5: Taiwan Cellular
APN: internet
600#8888#internet

(*no need to key in the "IP", when "User" & "APN_Password" are not required)
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Q3. When close Google Earth, a dialog box will prompt, asking if
you want to save the items in “Temporary Places” folders.

Please always select "No". Save "GooTracServer" and "Replay Server" will affect the
operation of GooTrac.

- Google Earth [ﬁ]

R

;’-F}'- ou have unsaved items in your "Temporary
. Place=" folder. Would you like to 2ave them

to your "My Places" folder?

T T g

If you have already saved the data in Google Earth, please remove all the folders
of "GooTracServer" & "ReplayServer" from Google Earth Sidebar -> “Places” and
"Temporary Places”.

¥ Places

_
s My Places
5 . @ GooTracServer
I W TAS
Taipei American School, Taipei,
Taiwan

+,E| L_:'.'_'I 5|ghtseemg
E Select this folder and click on
the 'Play’ button below, to start tt
. 5] Temporary Places

& [ E GooTracServer

* Please do stop the function of “Real-time Tracking” before you close “GooTrac” software,
and/ or Google Earth.
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Q4. Why the error message “Class not registered” prompt when | run

Q5.

GooTrac program?

It is because you did not install the correct Google Earth software into your computer
beforehand. Please download Google Earth Free Version (4.0 or later)

from http://earth.google.com/ before you run GooTrac software for the tracking. Please

note that Google Earth Plus & Professional can not work with GooTrac.

Why Data Switch —> Client always shows Server Dis-connected?

There are 2 possible reasons resulted to server disconnected.

1. Password
Please note that the password is case sensitive; capitalized letters will be judged as
different letters. Please key-in the password again; make sure the input Password &

Confirm Password are not capitalized.

2. Firewall or Anti-virus Software
The operation of GooTrac may be blocked by firewall or anti-virus software. Please
check your PC settings. If you are using the ICF (Internet Connection Firewall) built-in

XP, please make sure "GooTrac" is allowed.

Q6. What is the connection status of 10060?

"10060" is a Connection Time-out error. Generally, it happens when the computer
or service to be linked is turned off; or the IP set incorrectly that the link fails. For
GooTrac application, it is maybe owing to the IP is inside the firewall or router or
protected by anti-virus software.

For more details in this regard, please browse the following web page
http://help.globalscape.com/help/cuteftpb/index.html#socket _error = 10060.htm
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Q7.

Q8.

Q9.

What is the connection status of 100517

It indicates "Network is unreachable. A socket operation was attempted to an
unreachable network. This usually means the local software can not knows the route to
reach the remote host". Please check your IP & Port settings. For more data about the

networking error, please refer to http://msdn2.microsoft.com/en-us/library/aa450263.aspx

Can | use the vehicle icon created by myself ?

You can use the vehicle icon created by yourself , if the file format is GIF; the size is 32 *

32; and the image is saved at C:\Program Files\GoPass\GooTrac\images.

| can not use “History Replay” to replay my past driving routes.
Why?

Following are the basic requirements to replay your past driving routes.

1. The device installed in your vehicle must get a position fix - i.e. GPS LED should blink
once per second.

2. The vehicle must drive/ move around; and send the data back to GooTrac server (FIX
IP).

3. You must run GooTrac software in your PC when the vehicle is driving, so that the
records can be saved.

4. Please select Start -> History Replay -> Easy Replay -> select a vehicle -> select
a time period -> click "Reply" to prompt a new screen -> tick the Selection Box ->
double click on the data column -> the driving route will be display on Google Earth
map point by point.
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